
Compass 597 USB modem

with

User Guide

2130948
Rev 1.0



Compass 597 USB modem - User Guide

2 2130948

Important Notice Due to the nature of wireless communications, transmission 
and reception of data can never be guaranteed. Data may be 
delayed, corrupted (i.e., have errors) or be totally lost. 
Although significant delays or losses of data are rare when 
wireless devices such as the Sierra Wireless modem are used in 
a normal manner with a well‐constructed network, the Sierra 
Wireless modem should not be used in situations where failure 
to transmit or receive data could result in damage of any kind 
to the user or any other party, including but not limited to 
personal injury, death, or loss of property. Sierra Wireless 
accepts no responsibility for damages of any kind resulting 
from delays or errors in data transmitted or received using the 
Sierra Wireless modem, or for failure of the Sierra Wireless 
modem to transmit or receive such data.

Safety and Hazards Do not operate the Sierra Wireless modem:
• In areas where blasting is in progress
• Where explosive atmospheres may be present
• Near medical equipment
• Near life support equipment, or any equipment that may 

be susceptible to any form of radio interference. In such 
areas, the Sierra Wireless modem MUST BE POWERED 
OFF. The Sierra Wireless modem can transmit signals that 
could interfere with this equipment.

Do not operate the Sierra Wireless modem in any aircraft, 
whether the aircraft is on the ground or in flight. In aircraft, the 
Sierra Wireless modem MUST BE POWERED OFF. When 
operating, the Sierra Wireless modem can transmit signals that 
could interfere with various onboard systems.

Note: Some airlines may permit the use of cellular phones while the 
aircraft is on the ground and the door is open. The Sierra Wireless  
modem may be used at this time.

The driver or operator of any vehicle should not operate the 
Sierra Wireless modem while in control of a vehicle. Doing so 
will detract from the driver or operatorʹs control and operation 
of that vehicle. In some states and provinces, operating such 
communications devices while in control of a vehicle is an 
offence.
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Limitation of 
Liability

The information in this manual is subject to change without 
notice and does not represent a commitment on the part of 
Sierra Wireless. SIERRA WIRELESS AND ITS AFFILIATES 
SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL 
DIRECT, INDIRECT, SPECIAL, GENERAL, INCIDENTAL, 
CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES 
INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR 
REVENUE OR ANTICIPATED PROFITS OR REVENUE 
ARISING OUT OF THE USE OR INABILITY TO USE ANY 
SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS 
AND/OR ITS AFFILIATES HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR THEY ARE 
FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra 
Wireless and/or its affiliates aggregate liability arising under or 
in connection with the Sierra Wireless product, regardless of 
the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the 
Sierra Wireless product.

Patents Portions of this product may be covered by some or all of the 
following US patents:
5,515,013 5,629,960 5,845,216 5,847,553 5,878,234
5,890,057 5,929,815 6,169,884 6,191,741 6,199,168
6,339,405 6,359,591 6,400,336 6,516,204 6,561,851
6,643,501 6,653,979 6,697,030 6,785,830 6,845,249
6,847,830 6,876,697 6,879,585 6,886,049 6,968,171
6,985,757 7,023,878, 7,053,843 7,106,569 7,145,267
7,200,512 D442,170 D459,303
and other patents pending.

This product includes 
technology licensed from:

Licensed by QUALCOMM Incorporated under one or more of the 
following United States patents and/or their counterparts in other 
nations:
4,901,307 5,056,109 5,101,501 5,109,390 5,228,054
5,267,261 5,267,262 5,337,338 5,414,796 5,416,797
5,490,165 5,504,773 5,506,865 5,511,073 5,535,239
5,544,196 5,568,483 5,600,754 5,657,420 5,659,569
5,710,784 5,778,338

Manufactured or sold by Sierra Wireless Inc. or its Licensees 
under one or more patents licensed from InterDigital Group.

Copyright ©2008 Sierra Wireless. All rights reserved.
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Trademarks AirCard and “Heart of the Wireless Machine” are registered 
trademarks of Sierra Wireless. Watcher is a trademark of Sierra 
Wireless, registered in the European Community.
Sierra Wireless, the Sierra Wireless logo, TRU‐Install, 
TRU‐Locate, and the red wave design are trademarks of Sierra 
Wireless.

Windows® is a registered trademark of Microsoft Corporation.

Mac OS is a trademark of Apple Inc., registered in the U.S. and 
other countries.

PC Card and ExpressCard are trademarks of PCMCIA.

microSD is a trademark of SD Card Association.

QUALCOMM® is a registered trademark of QUALCOMM 
Incorporated. gpsOne is a trademark of QUALCOMM 
Incorporated.

InstallShield® is a registered trademark of Macrovision Corpo‐
ration in the United States of America and/or other countries.

Other trademarks are the property of the respective owners.

Contact 
Information

Additional 
information and 
updates

For up‐to‐date product descriptions, documentation, appli‐
cation notes, firmware upgrades, troubleshooting tips, and 
press releases, visit. www.sierrawireless.com.

Sales Desk: Phone: 1-604-232-1488

Hours: 8:00 AM to 5:00 PM Pacific Time

E-mail: sales@sierrawireless.com

Post: Sierra Wireless
13811 Wireless Way
Richmond, BC
Canada            V6V 3A4

Fax: 1-604-231-1109

Web: www.sierrawireless.com

mailto:sales@sierrawireless.com
http://www.sierrawireless.com
http://www.sierrawireless.com
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11: Introducing the Compass 597 
USB modem

Note: This document applies to you, only if your wireless device is the 
Compass 597 USB modem from Sierra Wireless. This document does 
not apply, if you are using an AirCard® 595 PC Card, AirCard 595U 
USB modem, AirCard 597E ExpressCard, or a wireless device that is 
built into your computer.

• Welcome
• Feature summary
• Package contents
• System components

Welcome
The Sierra Wireless Compass 597 USB modem is a dual‐band 
wireless USB modem for cellular and PCS networks, and the 
GPS frequency band. It enhances the functionality of your 
mobile computing device by adding 2‐way messaging and 
high‐speed mobile data in extended areas, compared to 
wireless local area networks.

This USB modem allows you to do the following (subject to 
feature availability), without using a wireline phone or 
network:
• Connect to the Internet, VPN and corporate networks
• Send and receive large e‐mail messages
• Send and receive SMS messages
• Use location‐based services
• Conduct video‐conferencing
• Access streaming, real‐time media
• Play games online

Note: You can view this guide online or print it to keep on hand. If 
you're viewing it online, simply click a topic in the Table of Contents, or 
a page number in the Index, or any page reference or section 
reference. (Most text that is blue is a clickable link.) The PDF 
automatically displays the appropriate page.
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Feature summary

Note: For step-by-step instruc-
tions to access features of the 
Compass USB modem, consult 
the online help available with 
Watcher® (page 33).

The Compass USB modem is designed to provide a wide range 
of capabilities using CDMA network technology. Implemen‐
tation of these features depends on the particular service 
provider and account features you have chosen.

Some features described in this manual may not be supported 
by your service provider or may not be available with your 
network account. For details of the services and accounts 
available, contact your service provider.

Wireless USB modem

Once installed and configured, the Compass USB modem can 
connect to the CDMA network automatically. You just insert 
the Compass USB modem, allow Watcher to autolaunch and 
authenticate your account on the network, then launch your 
Internet browser (which you can also configure in Watcher to 
launch automatically)—you’re online!

Alternatively, you can make a high‐speed data connection 
without running Watcher—simply by launching whatever 
application you want to use (such as your web browser or 
e‐mail application). Prerequisites: you must have previously 
selected, in Watcher, “Enable NIC for Data Connection” (subject to 
feature availability).

The Compass USB modem also allows you to dial up a modem 
(such as a corporate server).

TRU-Install

TRU‐Install™ is a Sierra Wireless feature that installs the 
necessary software and drivers the first time you insert the 
Compass USB modem into your Windows or Mac computer. 
An installation CD is not required.

TRU-Locate

With TRU‐Locate™, you can use location‐based services to 
query, for example, the network for information on points of 
interest that are near your current location, or display driving 
instructions.
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CDMA 3G services

The Compass USB modem operates over a type of wireless 
network called CDMA (Code Division Multiple Access).

CDMA 3G technology provides a variety of connectivity 
features, depending on your service provider and account:
• 1x‐EVDO Rev. A supports Internet connections with data 

rates up to 3.1 Mbps (downlink from the network) and 
1.8 Mbps (uplink to the network). Average data rates are 
450‐800 Kbps (downlink from the network) and 
300‐400 Kbps (uplink to the network). Actual speed 
depends on the network conditions.

• 1x‐EVDO Rev. 0 supports Internet connections with data 
rates up to 2.4 Mbps (downlink from the network) and 
153 Kbps (uplink to the network). Average data rates are 
400‐700 Kbps (downlink from the network) and 
40‐80 Kbps (uplink to the network). Actual speed depends 
on the network conditions.

• 1X supports Internet connections with data rates up to 
153 Kbps. Actual speed depends on the network condi‐
tions.

Once the connection is established, you can open your browser 
and connect to any web site that is accessible through the 
Internet, or access other Internet services (such as e‐mail).

The connection is “active” when data transmission is 
occurring. If data transmission stops for a period of time 
(determined by the network), the connection becomes 
dormant.
• Circuit switched (dial‐up) data, using the earlier CDMA 

IS‐95 specification, supports data connections to any dial‐
in service at rates up to 14.4 Kbps.

• QNC (Quick Net Connect) provides a simplified way to 
dial into an Internet connection (using circuit switched 
data) where 3G (1xEV‐DO or 1X) high‐speed packet 
service is not available.

• SMS (Short Message Service) allows you to send and 
receive short text messages using the Compass USB 
modem.
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Additional Compass USB modem 
features

Beyond the features of the CDMA network, the Compass USB 
modem provides additional software features:
• PIN security code to protect your Compass USB modem 

and account from unauthorized use.
• An Activation Wizard (page 23) to assist with configuring 

your CDMA account.
• Sound options to customize ringtones for SMS messages.
• A Call Log to track outgoing calls and determine the 

amount of data transferred.

The Compass USB modem has a microSD™ slot that can be 
used, with a microSD card (sold separately), for file transfer or 
storage.

Package contents
Your Compass USB modem package contains the following 
components:
• Compass 597 USB modem
• USB extension cable
• Notebook clip (to attach the Compass USB modem to your 

screen, if desired)
• Quick Start Guide

To install the Compass USB modem drivers and software, you 
do not need an installation CD. Your Compass USB modem 
uses the Sierra Wireless TRU‐Install feature. The drivers and 
software are installed when you insert the Compass USB 
modem into your computer.

System components
Your Compass 597 USB modem is just one part of a system 
designed to provide you with a wide range of communication 
features. Every component of the system is needed to enable 
these capabilities.
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Your host computing device

Your notebook or desktop computer hosts the Compass USB 
modem hardware and runs the communication software: your 
web browser or e‐mail application, and Watcher—the enabling 
software for the Compass USB modem.

You may also have other software on your computer that can 
be used wirelessly with the Compass USB modem, such as: file 
transfer applications (FTP), chat or instant messaging, a VPN 
(Virtual Private Network) client, client software for a corporate 
server application.

The Compass 597 USB modem

The Compass USB modem provides your computer with a 
connection to the CDMA wireless network.

The Compass USB modem fits into a USB slot available on 
most notebook and desktop PCs.

Every CDMA network operates on one of three radio 
frequency bands. As a dual‐band product, the Compass USB 
modem operates on two of these bands (see page 36), 
providing a wide coverage area.

The Compass USB modem drivers and 
enabling software

The Compass USB modem drivers and enabling software 
(Watcher) monitor and manage your wireless connections.

Your Compass USB modem uses the Sierra Wireless 
TRU‐Install feature—the drivers and software are installed 
when you insert the Compass USB modem into your 
computer.

The device driver software enables the Compass USB modem 
to work with your computer’s operating system.

Using the Watcher software, you can manage the 
Compass USB modem and monitor your connections. For 
step‐by‐step instructions to access features of Watcher, use the 
application’s online help.
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CDMA service provider account

Companies that operate CDMA networks and provide access 
to these networks are called service providers. To use the 
Compass USB modem, you must have an account with a 
CDMA service provider.

Note: You can use the Lock 
Modem feature to prevent others 
from using your account, should 
your Compass USB modem be 
stolen. For information on this 
feature, see the online help.

Each service provider has its own pricing options. There may 
be flat rate accounts, which provide you a maximum number 
of minutes of network usage for a fixed monthly fee. There 
may be accounts for which you are charged for network usage 
by the minute or by the amount of data transmitted.

Your account may include a variety of other services such as 
SMS messaging or location‐based services.

Each Compass USB modem has been provisioned at the 
factory for use with a particular service provider. This sets the 
Compass USB modem to use particular radio channels and 
enables services specific for that provider.

The process of setting up your account is called activation. 
Activation involves action by the service provider and configu‐
ration of the Compass USB modem.

The procedure to configure (activate) your Compass USB 
modem is covered in “Activation” on page 23.

The CDMA wireless network

Note: More information about 
CDMA networks is available on 
the CDMA Development Group 
web site, www.cdg.org.

This is the worldwide infrastructure providing the radio 
coverage that allows you to stay connected. Made up of radio 
towers and a variety of network switches, routers, and servers, 
the network is an interconnection of many service providers.

Note: Most service providers 
have coverage maps on their 
web sites.

There are CDMA networks that operate in the frequency bands 
supported by the Compass USB modem throughout North 
America and parts of Latin America, Asia, and New Zealand. 
However, each service provider operates a network that covers 
a limited geographical area within the overall CDMA coverage 
area.

Note: The fee for service is 
usually higher when you are 
roaming (connecting to a 
network other than the one 
belonging to your service 
provider).

Most service providers have “roaming” agreements with other 
service providers, so that they can offer service outside of the 
coverage area of their own networks. For example, assuming 
you live in Vancouver (Canada), and travel frequently to 
Seattle (United States), you can obtain an account with a 
Vancouver service provider that has a roaming agreement with 
a service provider in Seattle. You would then have local service 
in Vancouver, and roaming service in Seattle.

http://www.cdg.org
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22: Getting Started
• The Compass 597 

software
• Account activation and 

configuration

Before you can begin using the Compass USB modem, you 
must:
1. Insert the Compass USB modem, to install the enabling 

software and drivers.
2. Activate an account and configure the Compass USB 

modem to use your account (unless the Compass USB 
modem has been pre‐activated).

This section provides an overview of this process.

The Compass 597 software
The Compass USB modem comes with the following software:
• Watcher application that you use to manage the 

Compass USB modem and monitor your connections
• The driver software that provides the interface between 

the Compass USB modem and your Windows operating 
system

Detailed instructions for installing the Compass USB modem 
and its software are provided in “Installation” on page 17.

Account activation and 
configuration
To use the Compass USB modem, you must have an account 
with a CDMA service provider. The process of setting up an 
account is called activation.

If you purchased the Compass USB modem directly from a 
service provider, you may already have an account; your 
Compass USB modem may be pre‐activated.

Otherwise, run Watcher and the Activation Wizard, which 
guides you through the activation and configuration process. 
(Depending on your configuration, Watcher and the Activation 
Wizard may start automatically.)
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Configuring the Compass USB modem involves setting the 
phone number assigned by your service provider and may 
involve entering other network parameters and settings such 
as a user name and password to access services.

Your service provider needs to know:
• The billing information to use to collect payment for your 

network usage.
• The ESN (Electronic Serial Number) or MEID (Mobile 

Equipment Identifier) assigned to your Compass USB 
modem during the manufacturing process. (The ESN or 
MEID is printed on a label on the Compass USB modem 
and can be displayed in Watcher.) This number is used to 
help authenticate your account when you connect for 
service.

You require from your service provider:
• An activation code that gives you access to configure the 

account.
• A phone number for your Compass USB modem.
• Additional information specific to your service provider 

such as:
· A user ID (username) and password to authenticate your 
network connection.

· A SID (System IDentifier) that identifies your home 
network area and is used together with your phone 
number to determine if you are “home” or “roaming”.
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33: Installation
• System requirements
• Installation
• Inserting the 

Compass USB 
modem

• Removing the 
Compass USB 
modem

This chapter guides you through the steps necessary to install 
the Compass USB modem on a notebook or desktop computer.

The basic steps are:
1. Insert the Compass USB modem into the USB 

slot (page 20) to install the Compass USB modem drivers 
and the Watcher software.

2. If the Compass USB modem has not been pre‐activated, 
use the Activation Wizard to configure the Compass USB 
modem (as described in “Activation” on page 23).

Before you begin the installation process, ensure your PC is 
running a supported operating system and meets the 
hardware requirements described in the next section.

System requirements
The Compass USB modem is supported on notebook and 
desktop PCs running:
• Windows Vista
• Windows XP (Home and Professional versions) with 

Service Pack 2
• Windows 2000 with Service Pack 4 and roll‐up 1
• Mac OS X (supported through the Watcher Lite 

software—installed when you insert the Compass USB 
modem into your Mac). For detailed installation instruc‐
tions, download the Quick Start Guide from the Support 
section of www.sierrawireless.com)

http://www.sierrawireless.com/support/
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To install the Compass USB modem on a Windows computer, 
you require these system resources:

Compass USB modem 
installation procedures

Note: Users of Windows Vista and Windows 2000 must be logged in 
with administrative privileges to install the Compass USB modem 
software. Users of Windows XP may require administrative privi-
leges, depending on the Windows XP installation.

To install Watcher and the Compass USB modem drivers:

Note: Do not forcefully insert the 
Compass USB modem. This 
may damage the connector pins.

1. Insert the Compass USB modem into your USB slot (as 
described in “Inserting the Compass USB modem” on 
page 20).

2. If you’re running Windows Vista, in the AutoPlay window 
click Sierra Wireless Watcher Installation.
The Software Installation Wizard should start automati‐
cally.

3. In the installation window, click Next.
4. If the Open With... window appears, cancel the installation 

(your computer is missing some files required for the 
installation). Search for Instmsiw.exe (if you’re running 
Windows 2000) among the downloads at 
www.microsoft.com. Install the file on your computer, 
remove the Compass USB modem from your computer, 
then rerun the Compass USB modem installation.

5. If the Ikernel Application Error window appears:
a) Cancel the installation.
b) Download the file:

http://support.installshield.com/kb/files/Q108312/
ikernelupdate.exe.

Table 3-1: System resource requirements

USB slots One USB slot

I/O resources 1 IRQ, 40 bytes I/O space

Memory 32 MB

Disk space 32 MB

http://www.microsoft.com
http://support.installshield.com/kb/files/Q108312/ikernelupdate.exe.
http://support.installshield.com/kb/files/Q108312/ikernelupdate.exe.
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c) Install the file on your computer, remove the Com‐
pass USB modem from your computer, then rerun the 
Compass USB modem installation.

6. Use the Next and Back buttons to navigate through the 
wizard noting the following:
· To proceed with the installation, you must click I accept 

the terms in the license agreement to indicate your accep‐
tance of the terms of the license agreement.

· Use the default settings for the Destination Folder unless 
you have special requirements and an advanced under‐
standing of PC configuration. (The Destination Folder 
dictates where the software is installed.)

Windows detects the Compass USB modem and installs 
the drivers for it. This may take a few minutes. Once com‐
pleted, the system tray may display the message “Your 
devices are ready to use“ or “Your new hardware is 
installed and ready to use”:

7. When you are notified that the installation is complete, 
click Finish.

8. If Watcher has not started automatically, start it: double‐
click the Watcher icon   on your desktop.

Proceed to configure the Compass USB modem to use your 
account (if it was not pre‐activated). See “Activation” on 
page 23.
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USB modem insertion and 
removal

Inserting the Compass USB modem

To insert the Compass USB modem into a computer:
1. Gently insert the modem into the USB slot. Alternatively, 

you can attach the USB extension cable (included in your 
package) or the docking station (sold separately) to your 
computer’s USB slot, and insert the Compass USB modem 
into the USB extension cable or docking station.

Note: If your computer’s USB slot is vertical, use the USB extension 
cable or docking station.
Do not insert the modem into a USB hub or a USB slot on a keyboard.

Warning: If the orientation of your computer’s USB slot or the 
thickness of your computer are such that pressure is applied to the 
modem’s end or side (as shown by the red circle in the drawing 
below), you may damage the modem or your computer. In such 
cases, do not insert the modem directly into your computer’s USB 
slot; use the USB extension cable or docking station instead.

When you insert the Compass USB modem, the following 
should occur:
• The modem’s power LED   becomes lit.
• If sound effects are enabled, the PC beeps.
• The PC Card icon appears in the system tray, if it is not 

already displayed for another device (and unless the 
feature has been disabled).

• Watcher launches (unless the autolaunch feature has been 
disabled).

Windows Vista Windows XP Windows 2000
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The Compass USB modem is powered as soon as you insert it.

Removing the Compass USB modem

To remove the Compass USB modem:
1. Close Watcher if it is open.
2. Click the PC Card icon in the system tray to display the 

option to stop the device.

3. Click the entry for  “NEC PCI to USB Open Host Controller” 
or “Standard Enhanced PCI to USB Host Controller“.

4. If a dialog box appears notifying you that it is safe to 
remove the device, click OK.

5. Pull the modem out of the slot by gripping both sides of 
the modem and pulling the modem straight out.

Windows Vista Windows XP Windows 2000
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44: Activation
• Account configuration 

procedures
• Manual activation
• Automated activation Account configuration 

procedures
The final step to making the Compass USB modem operational 
is configuring it to use your CDMA service provider account. 
The process of activation configures your Compass USB 
modem with the required account parameters (phone number, 
username, password, and so on).

If you purchased a pre‐activated Compass USB modem, this 
step is not necessary. Once the application software and 
drivers are installed, the Compass USB modem is ready for 
use.

Otherwise, you must use the Activation Wizard to activate and 
configure your account.

Activation Wizard

The Activation Wizard walks you through the process of 
configuring an account. The process and options vary based on 
the service provider.

This section is a guide only. Consult the Quick Start Guide, and 
follow the directions on screen and instructions given by your 
service provider representative.

If your Compass USB modem does not have an activated 
account, and Watcher has started automatically, then the 
Activation Wizard should start automatically. If this does not 
happen:
1. Ensure Watcher is running. If it is not, double‐click the 

Watcher icon   on your desktop.

2. Start the Activation Wizard: select Tools > Activation Wizard.

To begin activation of the Compass USB modem, select the 
method (described in the following sections) and click Next.
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Manual activation
Activation involves phoning your service provider, 
exchanging information, and entering your account infor‐
mation into the appropriate fields in the wizard. (To use this 
method, you require a phone.)

To use manual activation, use the Next and Back buttons to 
navigate through the wizard, noting the following:
• Prepare your billing information, before you phone the 

service provider or proceed to the next window.
• Contact your service provider. Inform your service 

provider that you are activating your Sierra Wireless 
Compass 597 USB modem. The representative will request 
your ESN (Electronic Serial Number) or MEID. This is 
displayed in the Activation Wizard (and is printed on the 
Compass USB modem box and on the label on the back of 
the Compass USB modem).

• As prompted by the wizard, enter the information 
provided by the service representative.

• Select Finish in the final window of the wizard.

On completion of the Activation Wizard, the Compass USB 
modem is ready for use. The following chapters explain how 
to use Watcher to manage and monitor your connections.

Automated activation
To use automated activation:
1. Select the Automated Activation radio button and click Next.
2. The wizard advises that it will make a network connection, 

dialing the displayed number. Leave the number 
unchanged unless told by a technical service represen‐
tative to enter a different value. Click Next.

3. Follow any instructions or prompts provided to activate 
the USB modem.

Watcher displays the activation progress in the Call Status 
Area. When the process is complete you should see the 
message “Ready to Connect”.

Note: If you do not get the “Ready to Connect” message, retry the 
process. If the process continues to fail, use manual activation 
(page 24) or contact your service provider.

At this point your Compass USB modem is ready to use.
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55: Care and Maintenance of Your 
Compass USB modem

As with any electronic device, the Compass USB modem must 
be handled with care to ensure reliable operation. Follow these 
guidelines in using and storing the Compass USB modem:
• The Compass USB modem should fit easily into your USB 

slot. Forcing the Compass USB modem into a slot may 
damage connector pins.

• When inserting or removing the modem, always grip it by 
the sides rather than the end.

• Protect the modem from liquids, dust, and excessive heat.
• When not installed in your computer, store the 

Compass USB modem in a safe place.
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66: Watcher Basics
• Starting and closing 

Watcher
• Components of the 

Watcher Window
• Interpreting icons
• Online Help
• Warranty
• Troubleshooting
• Using an external 

antenna

Watcher is the application that allows you to manage and 
monitor the connection between the Compass USB modem 
and the CDMA network. You use Watcher to:
• Determine your signal strength, roaming status, 3G high‐

speed data availability, and other network connection 
parameters

• Initiate data calls
• Use location‐based services
• View call statistics
• Receive and send SMS messages
• Customize features and options

Depending on Watcher settings, you may be able to connect to 
the CDMA network without starting Watcher—simply by 
launching whatever application you want to use (such as your 
web browser or e‐mail application). However, Watcher and its 
icon in the system tray won’t be available for you to monitor 
the status of the connection. Location‐based services also won’t 
be available.

Starting and closing Watcher
Depending on your settings in the Options window, Watcher 
launches automatically anytime you insert the Compass USB 
modem. You can also launch Watcher by:
• Double‐clicking the Watcher icon  on your desktop
• Selecting:

In Windows Vista or Windows XP: Start > All Programs > 
Sierra Wireless > Watcher > Watcher
In Windows 2000: Start > Programs > Sierra Wireless > 
Watcher > Watcher
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The standard Windows control buttons in the upper right 
corner of the window are used to minimize or close Watcher. 
When minimized, Watcher does not appear as a taskbar 
button. Instead, an icon is shown in the system tray, usually at 
the right end of the taskbar. (See “Minimized icons” on 
page 32.)

Components of the Watcher 
window
The window has three areas that display messages and icons: 
the Connection Status Area (page 30), Call Status Area 
(page 31), and Indicator Area (page 32). These areas are shown 
in Figure 6‐1 that follows.

A menu bar is located on the upper left side of the window.

Windows control buttons are in the top right corner.

Figure 6-1: Watcher window

For a detailed description of each option in the menus, see the 
online help.

Window controls

• The Minimize button closes the Watcher window but leaves 
the application running. When Watcher is minimized, you 
can use the Watcher icon in the system tray to determine 
the Compass USB modem status. (See page 32.) This icon 
replaces a taskbar button for Watcher.
Once minimized, you can redisplay the Watcher window 
by selecting the Watcher icon in the system tray. You can 
also restore the window by double‐clicking the desktop 
shortcut or launching Watcher from the Start menu.

Toggle Full/Compact button

Close buttonMinimize button
Menu bar

Connection Status Area

Call Status Area

Indicator area button
Disconnect 
Connect/ 
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• The Toggle Full/Compact button   is used to switch 
between the full Watcher window and the compact view:

The compact view allows you to see connection status and 
indicators while using less space on the desktop. If you 
right‐click the compact view, a menu is displayed. From 
this menu you can open some of the other Watcher win‐
dows or establish/end a data connection.
To return to full view, select the view toggle button in the 
top right.

• The Close button   is used to exit Watcher.

Docking

You can set the Watcher window to “jump” to the edge of your 
screen when you move the window close to an edge. This lets 
you easily position Watcher in a corner of the screen.
• Select View > Docking

Always On Top

You can set Watcher to always display in front of other 
windows. This allows you to monitor connection status while 
using another maximized application, such as your web 
browser.
• Select View > Always On Top

Interpreting icons
Watcher makes extensive use of icons to indicate status and 
events. The various icons are described in the following 
sections on the display areas of Watcher.
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Connection Status Area

The Connection Status Area uses the icons shown in the 
following table.

Table 6-1: Connection Status Area icons

Icon Meaning

Compass USB modem not detected.

You may be able to resolve this by doing one of the 
following:
- Unlocking the modem (Tools > Unlock Modem)
- Powering the modem on (Tools > Turn Radio On)
- Ejecting the modem and re-inserting it

If this icon is still displayed, restart your computer.

The Signal Strength indicator uses bars to show the 
intensity of the radio signal. The number of bars 
increases as signal strength increases to a maximum 
of five bars.

When the bars are dimmed and the antenna icon is 
crossed out, no connection is possible for one of these 
reasons:
• You are outside the CDMA network coverage area
• The signal strength is too weak
• A network or account problem is preventing the 

Compass USB modem from obtaining service

1xEV-DO Rev. A icon.

1xEV-DO Rev. 0 icon.

1X icon.

When only the letters are displayed, you are within the 
coverage area, but have not yet acquired the service.
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Call Status Area

The Call Status Area displays messages related to the status or 
progress of a connection.

Where a duration timer is shown, timing begins when the call 
is initiated—not from the time the call is fully connected. This 
is a measure of the time the Compass USB modem has been 
using the radio channel (a wireless network resource).

“Click this display to exit PowerSave mode” indicates that the 
Compass USB modem could not find a system within a 
15 minute interval. To conserve power, the Compass USB 
modem reduces channel scanning to once every three minutes. 
To force the Compass USB modem out of PowerSave mode, 
click in the Call Status Area. The Compass USB modem 
performs a channel scan and, if no network is detected, returns 
to PowerSave mode.

When the indicator has a gray background, the network 
connection is dormant. (You are connected, but there is 
currently no traffic.)

When the indicator has a darker background, you have 
a data connection on the wireless service.

The Roaming Status indicator shows whether you are 
roaming onto the network of a service provider other 
than your own.

When the indicator is off (gray), you are within the local 
coverage area of your service provider. When the 
indicator is on (solid black), you are in a “preferred” 
roaming area. When the indicator is blinking, you are 
within the coverage area of a CDMA network but not in 
a “preferred” roaming area.

Your coverage area and account charges depend upon 
your service provider and the type of account you 
have. There may be surcharges for roaming service 
that vary based on whether you are in a preferred or 
non-preferred roaming area. If there is no roaming 
agreement between your service provider and the local 
carrier, you may be unable to complete calls.

Table 6-1: Connection Status Area icons (continued)

Icon Meaning
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Indicator area

The Indicator area displays an icon that notifies you when you 
receive SMS messages, and an icon that reflects the GPS status.

Minimized icons

Watcher displays an icon in the Windows system tray (which 
is usually located in the lower right corner of your screen). The 
system tray icon indicates your connection status or notifies 
you when you have SMS messages.

Table 6-2: Indicator Area icons

Icon Meaning

The SMS message indicator shows whether you have 
unread messages. A blinking icon indicates that there are 
one or more urgent or important unread messages.

To display the SMS Express window (in which the 
messages are displayed) select Tools > SMS Express… 
or double-click the icon.

If you position the mouse pointer over the GPS icon, the 
ToolTip shows the GPS status (on or off) or, if a tracking 
session is active, how many satellites are being tracked.

Double-click the icon to open the GPS Monitor window.

Table 6-3: System tray icons

Icon Meaning

Watcher cannot detect the modem. Ensure that the 
modem is powered on, not locked, and properly 
connected to your computer.

You are in service on the network but have no active data 
connection.
The number of red bars indicates the signal strength.

You have an active data connection.
The number of green bars indicates the signal strength.

You have a new SMS message.
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Only one icon can be displayed at a time. The priority of icons, 
from highest to lowest, is:
• No modem detected
• SMS message(s)
• Active or inactive connection.

For example, if you have unread SMS messages, and then 
establish a data connection, the icon still displays as an unread 
SMS message.

Online Help
Watcher includes extensive online help to provide operating 
hints and step‐by‐step instructions for getting the most from 
your Compass USB modem.

You can access online help in several ways:
• Press <F1> in any window.
• Use Windows Explorer to navigate to Program Files > 

Sierra Wireless Inc > 3G Watcher > Help > Watcher_ENU.chm. 
Double‐click to open the help file.

The help file has a table of contents, an index, and search 
capabilities.

Warranty
To access the warranty (PDF file):
• Windows Vista or Windows XP: select Start > All Programs > 

Sierra Wireless > Watcher > Warranty

• Windows 2000: select Start > Programs > Sierra Wireless > 
Watcher > Warranty

Troubleshooting
The online help includes descriptions of most common error 
messages. Look in the table of contents under Troubleshooting.

For help with other problems:
• Consult the Sierra Wireless web site at 

www.sierrawireless.com, where you will find an extensive 
knowledge base that can be searched to address most 
problems.

• Contact your service provider.

http://www.sierrawireless.com
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Using an external antenna
You can improve the signal strength, by attaching an external 
antenna (sold separately).

To attach the external antenna:
1. Remove the USB modem from your computer.
2. Flip open the tab (on the side of the modem).
3. Holding the antenna cable by the connector (end) part, 

carefully push the connector part of the cable into the 
corresponding connector on the Compass USB modem.

4. Carefully insert the USB modem into your computer’s USB 
slot.
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77: Technical Specifications
• LED operation
• Radio frequency and 

electrical 
specifications

• Environmental 
specifications

This chapter describes the function of the LEDs, and provides 
technical product data for the Compass USB modem.

LED operation
The Compass USB modem has two LED lights. The LEDs 
operate as follows:

Table 7-1: LED operation

LED State Indicates

Off The modem has no power. You have 
powered off the modem (Tools > Turn Radio 
Off), or the modem is not completely inserted 
into the USB slot, or the computer is in 
suspend mode (which powers down the 
modem).

Blue, not 
blinking

The modem has power and is working 
properly.

Blue, 
blinking

The modem’s firmware is being updated. Do 
not remove the modem.

Amber, 
blinking

The modem is searching for service.
If this LED state persists, see the online Help 
(“Not In Service“).

Amber, not 
blinking

An error has occurred. Remove the modem 
(page 21) and reinsert it.

Off No service is available.
See the online Help (“Not in Service”).

Amber, 
blinking

1X coverage is detected. Ready to connect 
to the network (click Connect).

Amber, not 
blinking

The modem is connected to the 1X network, 
and can send or receive data.

Blue, 
blinking

1x-EVDO coverage (Rev. 0 or Rev. A) is 
detected. Ready to connect to the network 
(click Connect).

Blue, not 
blinking

The modem is connected to the 1x-EVDO 
network, and can send or receive data.
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Radio frequency and electrical 
specifications
Table 7-2: Radio frequency and electrical 
specifications

Approvals Compliant with:
IS-2000 Release 1.0 (CDMA 1X)
IS-707-A Data, IS-856 (CDMA 1x-EVDO), IS-866, 
IS-878, IS-890,
CDMA Development Group
FCC (ID: N7NC597)
Industry Canada (ID: 2417C-C597)

Voltage +5.0 Vdc from USB slot

Current Maximum: 550 mA (from USB port)
Typical data call current (talk mode):

330 mA (1X)
410 mA (1xEV-DO)

Standby: 60 mA (1xEV-DO/IS2000 hybrid 
mode)

Transmitter 
power

200 mW (+23 dBm)

Transmit PCS: 1850 to 1909.95 MHz
Cellular: 824.04 to 848.97 MHz

Receive PCS: 1930 to 1989.95 MHz
Cellular: 869.04 to 893.97 MHz
GPS: 1575.42 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

±150 Hz
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Environmental specifications
Table 7-3: Environmental specifications

Operating 
temperature

-20 to +55°C

Storage 
temperature

-40 to +85°C 

Humidity 95%, non-condensing

Vibration Random vibration, 10 to 1000 Hz, nominal 6G 
RMS in each of 3 mutually perpendicular axes. 
Test duration of 60 minutes for each axis, for a 
total test time of 3 hours (non-operating)

Drop 1 m on concrete on each of 6 faces, 2 times
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88: Regulatory Information
• Important safety/

compliance 
information

Important safety/compliance 
information
The design of the Compass 597 USB modem complies with 
U.S. Federal Communications Commission (FCC) and 
Industry Canada (IC) guidelines respecting safety levels of 
radio frequency (RF) exposure for portable devices, which in 
turn are consistent with the following safety standards previ‐
ously set by Canadian, U.S. and international standards 
bodies:
• ANSI / IEEE C95.1‐1999, IEEE Standard for Safety Levels with 

Respect to Human Exposure to Radio Frequency Electromag‐
netic Fields, 3kHz to 300 GHz

• National Council on Radiation Protection and Measure‐
ments (NCRP) Report 86, ‐1986, Biological Effects and 
Exposure Criteria for Radio Frequency Electromagnetic Fields

• Health Canada, Safety Code 6, 1999, Limits of Human 
Exposure to Radio frequency Electromagnetic Fields in the 
Frequency Range from 3 kHz to 300 GHz

• International Commission on Non‐Ionising Radiation 
Protection (ICNIRP) 1998, Guidelines for limiting exposure to 
time‐varying electric, magnetic, and electromagnetic fields (up 
to 300 GHz)

FCC ID: N7NC597

CAUTION: The Compass 597 USB modem has been tested for 
compliance with FCC / IC RF exposure limits in the laptop 
computer(s) configurations with a horizontal USB slot and can 
be used in laptop computers with substantially similar 
physical dimensions, construction, and electrical and RF 
characteristics. This USB modem must not be co‐located or 
operated in conjunction with any other antenna or transmitter. 
Use of this device in any other configuration may exceed the 
FCC RF Exposure compliance limit. Note: If this USB modem 
is intended for use in any other portable device, you are 
responsible for separate approval to satisfy the SAR require‐
ments of Part 2.1093 of FCC rules.

NOTE: If your computer’s USB slot is vertical, use the USB 
extension cable or docking station. Do not insert the modem 
into a USB hub or a USB slot on a keyboard.

WARNING: If the orientation of your computer’s USB slot or the 
thickness of your computer are such that pressure is applied to 
the modem’s end or side, you may damage the modem or your 
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computer. In such cases, do not insert the modem directly into 
your computer’s USB slot; use the USB extension cable or 
docking station instead.

WARNING (EMI) - United States FCC Information ‐ This equipment 
has been tested and found to comply with the limits for a 
Class B computing device peripheral, pursuant to Part 15, 22, 
and 24 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation.

This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that inter‐
ference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician 

for help.

This device complies with Part 15 of the FCC Rules. Operation 
is subject to the condition that this device does not cause 
harmful interference.

CAUTION: Any changes or  modifications not expressly 
approved by Sierra Wireless could void the user’s authority to 
operate the equipment.

WARNING (EMI) - Canada ‐ This digital apparatus does not 
exceed the Class B limits for radio noise emissions from digital 
apparatus as set out in the interference causing equipment 
standard entitled ʺDigital Apparatusʺ, ICES‐003 of the 
Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélec‐
triques applicables aux appareils numériques de Classe B 
prescrites dans la norme sur le matériel brouilleur: ʺAppareils 
Numériquesʺ, NMB‐003 édictée par le ministre des Communi‐
cations.

If you have purchased this product under a United States 
Government contract, it shall be subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of Defense Federal Acquisitions 
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Regulations (DFARs) Section 252.227‐7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions 
Regulations (FARs) Section 52.227‐19 for civilian agency 
contracts or any successor regulations. If further government 
regulations apply, it is your responsibility to ensure 
compliance with such regulations.
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AAppendix A: Glossary
1X One Times Radio Transmission Technology (the ʺone timesʺ 

refers to the frequency spectrum). Supports Internet 
connections with data rates up to 153 Kbps. Actual speed 
depends on the network conditions. Compare to 1x‐EVDO.

1x-EVDO A high‐speed standard for cellular packet data communica‐
tions. 

Rev. A supports Internet connections with data rates up to 
3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink 
to the network).

Rev. 0 supports Internet connections with data rates up to 
2.4 Mbps (downlink from the network) and 153 Kbps (uplink 
to the network). 

Average data rates are: for Rev. A: 450–800 Kbps (downlink 
from the network) and 300–400 Kbps (uplink to the network); 
for Rev. 0: 400‐700 Kbps (downlink from the network) and 
40‐80 Kbps (uplink to the network). 

Actual speed depends on the network conditions. Compare to 
1X.

bps bits per second—The actual data speed over the transmission 
medium.

CDMA Code Division Multiple Access—A wideband spread spectrum 
technique used in digital cellular, personal communications 
services, and other wireless networks.  Wide channels 
(1.25 MHz) are obtained through spread spectrum transmis‐
sions, thus allowing many active users to share the same 
channel. Each user is assigned a unique digital code, which 
differentiates the individual conversations on the same 
channel.

CDMA 1X Also known as 1X, this is a high‐speed standard for CDMA 
cellular communications.

dormant The packet data connection has the logical PPP session left 
open while the underlying physical link (the radio channel) is 
released. When traffic is to resume, a radio channel is 
re‐acquired and the original PPP session resumes.

ESN Electronic Serial Number—The unique first‐generation serial 
number assigned to the Compass USB modem for cellular 
network use. Compare to MEID.

ExpressCard™ Add‐in memory and communications cards for portable 
computers. ExpressCard is a trademark of the PCMCIA.
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FCC Federal Communications Commission—The U.S. federal 
agency that is responsible for interstate and foreign communi‐
cations. The FCC regulates commercial and private radio 
spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast 
licensing.  Consult www.fcc.gov.

GPS Global Positioning System—A system that uses a series of 24 
geosynchronous satellites to provide navigational data.

firmware Software stored in ROM or EEPROM; essential programs that 
remain even when the system is turned off.  Firmware is easier 
to change than hardware but more permanent than software 
stored on disk.

host • A computer that uses a modem or a similar device to 
answer a calling computer.

• A source or destination in the communication network.
• A computer that contains data or files to be accessed by 

client computers.  Also known as a server.

IS Interim Standard—After receiving industry consensus, the TIA 
forwards the standard to ANSI for approval.

IS-95 The standard for CDMA.

Kbps Kilobits per second—Actually 1000, not 1024, as used in 
computer memory size measurements of kilobytes.

LAN Local Area Network

LED Light Emitting Diode—A semiconductor diode that emits 
visible or infrared light.

MEID Mobile Equipment Identifier—The unique second‐generation 
serial number assigned to the Compass USB modem for 
cellular network use. Compare to ESN.

MHz Mega‐Hertz—One million cycles per second.

Mbps Megabits per second

packet A short fixed‐length block of data, including a header, that is 
transmitted as a unit in a communications network.

PC Card™ Add‐in memory and communications cards for portable 
computers. PC Card is a trademark of the PCMCIA.

PCMCIA Personal Computer Memory Card International 
Association—The organization that standardizes 
ExpressCards and PC Cards.

PCS Personal Communications Services—A cellular 
communication infrastructure that uses a different frequency 
range than AMPS.

http://www.fcc.gov
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roaming A cellular subscriber is in an area where service is obtained 
from a cellular service provider that is not the subscriber’s 
provider.

SMS Short message services—A feature that allows users of a 
wireless device on a wireless network to receive or transmit 
short electronic alphanumeric messages (up to 160 characters, 
depending on the service provider).

system tray Usually located in the lower right corner of your screen

TIA Telecommunications Industry Association—A standards‐
setting trade organization, whose members provide 
communications and information technology products, 
systems, distribution services and professional services in the 
United States and around the world. Consult www.tiaonline.org.

VPN Virtual Private Network

http://www.tiaonline.org
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